
 
 
 

 

 
 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

KBLog履歴データの閲覧方法 

KEK版Control System Studio 

 
  
 
   
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

バージョン: 1.0 

ステータス: Release 

ファイル: css_databrowser_kblog_usage.pdf 

 作成者: Satoshi Ueda, Takashi Nakamoto  

最終更新日: December 22, 2011 

 



Release 

 

 
Copyright © 2011 by Cosylab – ii – Public 

 
 

履歴 

バージョン 日付 更新者 変更部分 変更内容 

0.1 2011-11-21 sueda 全て アウトラインの作成 

0.2 2011-11-27 sueda 1 「1.1 概要」を執筆 

0.3 2011-12-18 sueda 1 「1.2 画面」の一部を執筆 

0.4 2011-12-21 sueda 1 「1.2 画面」の残りを執筆 

1.0 2011-12-22 tnakamoto 全て KBLogに関する部分を加筆、構成を変更 

 

文書の公開について 

本文書は公開文書です。下記の公開範囲に含まれる組織または人物が閲覧することができ

ます。 

公開範囲 

本文書は KEKの職員とオペレータの他、どなたでも閲覧することができます。 

 

目的 

本文書は、KEK版 CSSのユーザーが対象です。KEK版 Control System Studio(CSS) 3.0.1で

は新たに KBLogからの履歴データの読み出しがサポートされました。本文書では、KBLogか

ら履歴データを読み出して CSSの Data Browserで履歴データを表示させる方法について説

明します。
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1. はじめに 

KEK 版 CSS 3.0.1 [1]では新しく KBLog からの履歴データの読み出しができるようになりまし

た。これにより、過去に KBLogにてアーカイブされたデータを CSSの Data Browser上で表示

させることができます。本ドキュメントは、CSSの Data Browser上で KBLogにてアーカイブされ

たデータを表示させるための方法を解説します。 

なお、kblogrd コマンドがある環境で CSS を起動した場合にのみ KBLog の履歴データを閲覧

できるようになっています。また、Linux と Mac OS X のみを対象としており、Windows につい

てはサポートされていません。 

1.1. KBLOGの設定 

インストール手順書[2]に従い、 KEK版 CSSをインストールし、SuperKEKB向けの起動スクリ

プトを用いて CSS を起動すると、KBLog がデフォルトのアーカイバとして設定されています。

デフォルトでは、abco4.kekb.kek.jp 上にて設定を変更することなく Data Browserを用いれ

ばすぐに履歴データを表示できるように設定がされています。 

1.1.1. アーカイバのURLの設定 

KBLogアーカイバの URLはデフォルトで kblog:///KEKBLog  となっています。この URLは、

KBLog関連のファイル（ログファイル、lcfファイル）などがある親ディレクトリが/KEKBLog であ

ることを示しています。 

もし他のディレクトリにこれらのファイルがある場合には、この URL を変更する必要がありま

す。この URLを変更するには、acc_settings.sh （Linux版では CSSのルートディレクトリ、

Mac OS X版では css_kek_superkekb.app/Contents/MacOS にあります）をエディタ等で

開き、下記の行を書き換えてください。 

SUPERKEKB_ARCHIVE_URLS=”kblog:///KEKBLog” 

なお、KBLogの場合には、URLは必ず kblog:// からはじめ、ルートディレクトリからのパス

をその後に付け足します。 

1.1.2. KBLog の設定 

KBLog の設定ダイアログを開くには、CSSのメインメニューから Edit → Preferencesを選択し、

さらに Preferencesダイアログで CSS Applications → Trends → KBLogを選択してください。

Figure 1 に示すダイアログが開かれます。このダイアログで設定可能な項目と説明について

は、Table 1を参照してください。 
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Figure 1 : KBLogの設定ダイアログ 

 

項目 デフォルト値 説明 

Path to kblogrd /usr/local/bin/kblogrd kblogrdコマンドの絶対パス。 

Relative path to sub 

archive file from the root 
SYS/KEKBLog.list 

アーカイバの URL で指定した

ディレクトリからの

KEKBLog.listの相対パス。  

Relative path to LCF file 

directory from the root of 

kblog 
SYS/LCF 

アーカイバの URL で指定した

ディレクトリからの*.lcfがあ

るディレクトリへの相対パス。  

Reduce the amount of 

data transferred from 

kblogrd 
No 

kblogrdコマンドからのデータ

転送量を抑制するかどうか。

詳細は「2.9 kblogrdからのデ

ータ転送量の節約」を参照の

こと。 

Table 1: KBLog について変更可能な設定項目 
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2. DATA BROWSERの使用方法 

ここでは、CSS にて KBLog の履歴データを表示させるために、Data Browser の基本的な使い

方について説明します。なお、 Data Browser の詳細な使い方については、CSS のヘルプの

CSS Applications → Trends → Data Browserを参照してください。 

2.1. 概要 

Data Browser は、CSS に実装されているツールの一つで、リアルタイムで取得した PV（チャネ

ル）の値や、アーカイブされた PV の値を、ストリップチャートにプロットします。Strip Tool や

Archive Viewer と同様の機能を提供しますが、CSS の他のツールと親和性が高く、より使いや

すくなっています。 

2.2. DATA BROWSERパースペクティブ 

Data Browserパースペクティブでは、プロット画面の他に、左側に PVの検索ができる Archive 

Searchビューが、下部には Propertiesビューや Export Samplesビューが表示されるようになっ

ており、履歴データを見るのに適した画面構成になっています。 

 

 

Figure 2 : Data Browserパースペクティブ 



KBLog履歴データの閲覧方法 Release 2.Data Browserの使用方法 

 

 
 

 
Copyright © 2011 by Cosylab 8 / 25 Public 

 
 
 

Data Browser パースペクティブに移行するには Window → Open Perspective → Other → 

Data Browser を選択します。パースペクティブ上では、各ビューを閉じたり、大きさを変更した

りすることができます。 

2.3.  履歴データの表示 

履歴データを Data Browser にグラフとして表示させる方法について説明します。 

2.3.1. PVの検索 

まず、表示させたい PVを Archive Search ビューにて検索します。表示させたい PV名の全て

または一部を Pattern 欄に入力して Searchボタンをクリックしてください。ここで、Figure 3のよ

うな警告ダイアログが表示されますが、KBLogの場合には PVの検索にはほとんど時間がか

かりませんので、OKボタンをクリックしてください。すると、Archive Searchビューの最下部にヒ

ットした PV 名が列挙されます。なお、PV 名の右側の Name 欄に表示されているのはアーカ

イブ名です。アーカイブ名に関する説明については、「2.8 アーカイブとデータソース」を参照し

てください。 

 

 

Figure 3 : 検索開始時に表示される警告ダイアログ 

なお、検索する PV名にはワイルドカードとして ”?” と”*” を含ませることができます。 ”?” は

任意の一文字を表し、”*” は任意の長さの文字列を表します。 

また、検索に正規表現を用いたい場合には、Reg.Exp.にチェックを入れ、Pattern 欄に正規表

現を入力してください。正規表現に関する説明については、CSSのヘルプの CSS Applications 

→ Trends → Data Browser → Searchを参照してください。 
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Figure 4 : PVの検索例 Figure 5 : 正規表現を用いた検索 

2.3.2. 新規のプロットの作成 

PVの検索ができたら、ツールバーにある ボタン（Open new Data Browser plot）をクリックし

て、新規のプロット画面を作成してください。そして、Archive Search ビューに表示されている

PV をプロット画面上にドラッグしてください。すると、直近 1 時間以内の履歴データが表示さ

れます。また、Channel Access 経由で取得される現在値が随時取得され、プロット画面がその

たびに更新されます。当然、その期間内に履歴データがない場合には、何も表示されません。

プロット画面上の時間軸を変更するには、プロット画面上部にある ボタン（Open start/end 

time dialog box）をクリックし、時間軸の開始時刻と終了時刻を設定してください。 

Figure 6は、 BM_DCCT:LCURの 2010年 5月 12日から 1か月分のデータを表示させていま

す。プロット画面上では、時間軸を適当な間隔に分割し、各時間間隔の平均値、最大値、最

小値が表示されています。平均値は、濃い色の線で表されています。また、最大値と最小値

については、その値の範囲が薄い色で示されています。 

 



KBLog履歴データの閲覧方法 Release 2.Data Browserの使用方法 

 

 
 

 
Copyright © 2011 by Cosylab 10 / 25 Public 

 
 
 

 

Figure 6 : BM_DCCT:LCURの履歴データを表示 

なお、プロット画面の時間軸が長いか、対象とする PV のサンプリングレートが高い場合には、

履歴データを取得するのに実行している kblogrd コマンドが完了するまでにかなりの時間が

かかる場合があります。プロット画面は kblogrd コマンドが完了するまで更新されませんので、

注意してください。なお、履歴データの取得を途中で中断したい場合には、「2.7 履歴データ取

得の」を参照してください。 

また、プロット画面上には複数の PV を表示させることができます。 プロット画面上にさらに

PV を追加するには、Archive Search ビューから別の PV をそのプロット画面上にドラッグする

だけです。 

なお、プロット画面上で右クリックして Add PV を選択し、プロットしたい PV 名を入力すること

でも履歴データを表示させることはできますが、この場合には全てのデフォルトのデータソー

スを検索しようとするため、データを表示させるのに時間がかかる場合があるため、あまりお

勧めはしません。データソースに関する詳細な説明については、「2.8 アーカイブとデータソー

ス」を参照してください。 

2.3.3. プロット画面の使い方 

プロット画面上で右クリックすることで利用できる機能を以下の表に示します。 

 

ドラッグ 
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Figure 7 : プロット画面上で右クリックした場合のメニュー画面 
 

メニュー 説明 

Hide [Show] Toolbar プロットツールバーを隠し[表示し]ます。 

Add PV PV のプロットを作成します。 

Add Formula PV の値に何らかの演算を施した値を表示させることができます。複数の

PVの値を用いて演算をさせることもできます。それぞれの PVの値が

x1、 x2 というように表示されるので、x1+x2 などのように入力します

（Figure 8）。 

Remove Empty Axes ラベルの付けられていない軸を削除します。 

Open Properties Panel Properties ビューを開きます（2.3.4）。 

Open Archive Search Panel Archive Search ビューを開きます。 

Open Data Export Panel Export Samples ビューを開きます（2.3.5）。 

Inspect Samples Inspect Samples ビューを開きます（2.3.6）。 

Inspect Waveforms Inspect Waveforms ビューを開きます（2.3.7）。 

Data Browser Perspective パースペクティブを変更、またはリセットします（2.4）。 

Table 2 : プロット画面上で右クリックしたときのメニュー 
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Figure 8 : Formulaの設定ダイアログ 

プロットツールバーは、プロット画面を操作するための機能を提供します。機能の詳細を以下

の表に示します。 

 

 

Figure 9 : プロットツールバー 
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意味 説明 

Configure Settings グラフの表示を設定するためのダイアログを開きます。 

Add Annotation プロットの一点に注釈を付けることができます（Figure 10）。初めのクリックで注釈の

設定ダイアログが開かれ、次のクリックで注釈をグラフ上に付加します。 

Remove Annotation 注釈を消去します。 

Stagger Axes 各プロットが重ならないように縦軸の値を調整します。 

Rubberband Zoom 長方形上にドラッグすることでチャートの一部を拡大します。 

Horizontal Zoom 一部をドラッグすることで横軸に対しチャートを拡大します。 

Vertical Zoom 一部をドラッグすることで縦軸に対しチャートを拡大します。 

Zoom In Horizontally 横軸の表示範囲を狭めます（短期間のチャートの変化を見たいときに利用します）。 

Zoom Out Horizontally 横軸の表示範囲を広げます（長期間のチャートの変化を見たいときに利用します）。 

Zoom In Vertically 縦軸の表示範囲を狭めます。 

Zoom Out Vertically 縦軸の表示範囲を広げます。 

Panning ドラッグしながら軸やプロットを動かしてドロップすることで、見たいポイントまでチャー

トを遡ることができます。 

None Zoom などが有効になっているとき、その機能を解除したいときに使います。 

Undo 前の作業を取り消します。 

Redo 前の取り消しを取り消します。 

Save Snapshot チャートをスナップショットとして画像に保存するダイアログを開きます。 

Enable/Disable Scrolling ストリップチャート表示をするか横軸を固定するかを設定します。 

Open Start/End Dialog 

Box 

横軸の範囲を指定するダイアログを開きます。 

Table 3 : プロットツールバーの機能 
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Figure 10 : 注釈の例 

2.3.4. Propertiesビュー 

Propertiesビューにおいては、プロットの設定を行うことができます。Propertiesビューは CSSの

BOY などといった他のアプリケーションと共通なので、アクティブになっているアプリケーショ

ンの Properties を表示します。多くのプロット画面をそれぞれ比較したいときなど、あるプロット

画面にある Properties ビューを関連付けたい場合には、 ボタンを押した状態にします。ま

た、 ボタンを押し新たなビューを開くこともできます。 

Tracesタブでは、各 PVのプロットの設定を行います。 
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メニュー 説明 

Trace チェックを外すことで、一時的にプロットを表示しないようにできます。 

Item PV 名、または Formula 名を示します。 

Display Name 凡例における PVの表示名を設定します。 

Color 表示色を設定します。 

Scan Period PV の値をスキャンする頻度を設定します。0 を入力すると、その PV で

設定されているスキャン間隔がそのまま適用されます。 

Buffer Size 保持する最大サンプル数を設定します。 

Width プロット線の太さを設定します。 

Axis どの縦軸に対応するかを設定します。 

Trace Type プロットの表示方法を設定します。 

Request Optimized を指定すると、ある一定数のサンプルの平均値・最大最小値

を取って表示します。この数は Preferences で設定できます。こうするこ

とで、PVの値が安定して変化しているかがわかりやすいというメリットが

あり、基本的にはこちらを指定します。 

Raw Data を指定すると、サンプルの値をそのまま表示します。列挙型な

どをグラフで表示させる場合には、その平均値などは全く意味を持ちま

せんので、Raw Data を指定するとよいでしょう。ただし、Raw Data を選

択すると CSS の動作が非常に重たくなる場合があるので注意してくださ

い。 

Table 4 : Tracesタブ 

Time Axisタブでは、横軸（時間軸）についての設定を行います。 

Value Axesタブでは、縦軸についての設定を行います。 

Miscタブでは、表示を更新する頻度、背景色の設定を行います。 

2.3.5. Export Samplesビュー 

Export Samples ビューにおいては、データを Excel のようなスプレッドシートや Matlab 用のデ

ータとして出力することができます。 

Samples to Export の項では、出力範囲、Source （Plot、  Raw Archived Data、  Optimized 

Archived Data）を指定します。Source の詳細については、Properties ビューを参照してください。 

Formatの項では、出力形式、出力内容、数値の表示形式を指定します。 

Output の項では、出力するファイル名を指定します。Export ボタンを押すことで出力されます。 
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2.3.6. Inspect Samplesビュー 

各 PV の時間ごとの値を表の形で表示します。このビューはデフォルトでは表示されません。

プロット画面を右クリックして Inspect Samplesをクリックし表示させてください。 

 

 

Figure 11 : Inspect Samplesビュー 

まず、Source欄に kblogと表示されているデータは KBLogから取得された履歴データです。 

KBLog から取得された履歴データのうち、Quality 欄に Original と表示されている場合には、

実際に kblogrd コマンドから得られたデータそのものであることを表しています。一方で、

Quality 欄に Interpolated と表示されているデータは、プロット画面に表示する際に計算された

ある時間間隔ごとの平均値、最大値、最小値になります。Time欄には、その時間間隔の中央

の時刻が表示されます。 

また、Severity欄と Status欄については、Channel Accessを通じて得られた値については、その

PV の Severity と Status が表示される一方で、KBLog から得られた履歴データについては、

Severity と Status が記録されていないため、通常何も表示されません。しかし、KBLog

に”Connected”、”Disconnected”と記録されているものについては、そのまま Inspect Samples

ビューの Severity 欄と Status 欄に表示されます。また、”Connected”、”Disconnected”について

はプロット画面上に Figure 12のように、時間軸上に点として表示されています。 
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Figure 12 : “Connected”がプロット画面上に表示されている例 

なお、仕様上、新たに KBLogや Channel Accessを経て得られたデータは Inspect Samplesビュ

ーの表に自動的に反映されません。最新の取得したデータをこの表でみるためには、そのつ

ど Refreshボタンを押す必要があります。 

2.3.7. Inspect Waveformsビュー 

波形データ（配列）の Indexごとの値をグラフの形で表示するためのビューです。このビューは

デフォルトでは表示されません。プロット画面を右クリックして Inspect Waveforms をクリックし

表示させてください。 

波形データを表示させるためには、まず対象とする PV を通常の方法で Data Browser のプロ

ット画面上に表示させてください。プロット画面上には、その波形（配列）の最初の要素の履歴

データが表示されます。その後、Inspect Waveformsビューにて Item (PV、 Formula): と書かれ

ているところで、表示させたい波形を保持している PVを選択することで、Figure 13のように波

形のスナップショットが表示されます。どの時刻の波形が表示されているのかは、ビュー下部

の Timestamp を見ればわかります。また、ビュー下部のスクロールバーをスクロールすること

で、他の時刻の波形を見ることができます。 

 

Figure 13 : Inspect Waveformsビュー 
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なお、 KBLog から波形（配列）の履歴データを取得する際には、全ての配列データを取得し

ません。波形データは場合によっては CSS の動作を非常に重たくさせるため、ある程度間引

きした状態で取得されます。間引きせずに、KBLog にアーカイブされた全ての配列データを

見たい場合には、Propertiesビューにて波形データを保持する PVの Requestを”Raw Data”に

変更し、さらに Inspect Waveforms ビューにて Refresh ボタンを押すことでできます。しか

し、”Raw Data”を選択することで、CSS の挙動が非常に遅くなる可能性があるので注意してく

ださい。 

2.4. DATA BROWSERパースペクティブのリセット 

データブラウザではビューを動かしたり、大きさを変更したり、ビューを消したりといったことが

できますが、作業している内に画面構成がごちゃごちゃとしまうことがあります。また Archive 

Search ビューや Properties ビューといった、履歴データを表示させるのに欠かせないビューを

消してしまったといったこともあるでしょう。そのような場合には、Data Browserのパースペクテ

ィブをデフォルトの状態に戻してください。デフォルトの状態に戻すには、プロット画面上で右

クリック → Data Browser Perspectiveを選択すると、 Reset? というダイアログが表示されるの

で、Yesボタンをクリックしてください。 

これにより、左側に Archive Search ビューと Navigator ビュー、下側に Properties ビューと

Export Samplesビューが表示されるデフォルトの画面構成に戻ります。 

2.5. ARCHIVE SEARCHビューから新規プロット画面を開く 

Archive Searchビューにて PV名を検索した後、PV名を右クリックし、 Process Variable→ Data 

Data Browserと選択することで、新たにプロット画面が開き、その PVが表示されます。 

2.6. ARCHIVE SEARCHビューにて検索結果を追加していく 

Archive Searchビューにて、デフォルトでは Replace search resultというオプションが有効になっ

ています。このオプションは、Search ボタンをクリックするたびに、リスト上に表示されている

過去の検索結果を新しい検索結果を置き換えます。 

一方で、Add search resultを選択すると、Searchボタンをクリックするたびに、リスト上に表示さ

れている過去の検索結果に、さらに新しい検索により見つかった PVが追加されます。 

なお、Archive Searchビューの幅が狭い場合には、” Add search result”と” Replace search result”

という項目のラベルが潰れて一部が見えないかもしれませんが、”Add…”や”Replace …”など

と表示されているのがそれです。 
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Figure 14 : 検索のオプション 

2.7. 履歴データ取得の中断 

プロット画面の時間が長かったり、対象とする PVのサンプリングレートが高かったりする場合

には、KBLog から取得するデータ点数が多くなり、プロット画面に表示されるまでにかなりの

時間待たされる場合があります。データを取得中に他の操作をすることもできますが、このデ

ータ取得の操作を中断させることもできます。 

データ取得中には、CSS のウィンドウの下部に Figure 15 のようにステータスバーが表示され

ます。 

 

Figure 15 :  データ取得中に表示されるステータスバー 

ここで、 ボタンをクリックすることにより、Figure 16 のように Progress ビューが表示されます。

この Progressビューには、履歴データ取得に限らず、CSSのバックグラウンドで走っているあら

ゆる処理が表示されます。その中で、履歴データ取得の処理に関しては”Read data: …“と表

示されているので、その項目の右側にある ボタンをクリックすることで、KBLog からのデー

タの取得を中断させることができます。 

 

Figure 16 :  Progressビュー 
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2.8. アーカイブとデータソース 

CSS では複数のアーカイバから履歴データを取得できるようになっています。そこで、履歴デ

ータを提供してくれるもののことをデータソースと呼びます。データソースは、かならずしもアー

カイバと 1対 1 で対応する概念ではありません。 

KBLog の場合、履歴データはいくつかのアーカイブに分けられて保存されており、この一つ

一つのアーカイブのことを CSS ではデータソースと呼んでいます。CSS のメインメニューから

Edit → Preferencesを選択し、さらに Preferencesダイアログで CSS Applications → Trends → 

Data Browser を選択してください。Figure 17 のようなダイアログが表示されるはずですが、そ

の最下部にデフォルトのデータソースが列挙されています。SuperKEKB 向けの起動スクリプ

トを用いて CSS を起動すると、Figure 17 のように KBLog にあるデータソースが自動的にデフ

ォルトのデータソース群として登録されます。必要であれば、このダイアログにてデフォルトの

データソース群に新たにデータソースを加えたり、既存のものを取り除いたりすることができま

す。 

 

 

Figure 17 :  デフォルトのデータソースの一覧 
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1 つのデータソースは Name、Key、URLから成っています。KBLogの場合には、「1.1.1アーカ

イバの URLの設定」で説明したとおり URLは必ず kblog://ではじまります。また、Nameは

KBLog 内でのアーカイブの名前で、例えば BM/DCCT_yyyymmddhhmmss.log1 及び

BM/DCCT_yyyymmddhhmmss.log2 というログファイルがありますが、この BM/DCCTがアーカ

イブ名になります。このアーカイブ名は PV の検索や、kblogrd コマンドを実行するときに末尾

の引数として使われるものです。Key は、その URL 内で 1 つ 1 つのアーカイブに与えられる

ユニークな整数であり、KBLogの場合には、KEKBLog.list 内でのアーカイブ名の順番がそ

のまま Keyになっています。 

あらかじめ自分が閲覧したい PV が属するアーカイブ名が分かっている場合には、Archive 

Search ビューで検索をするときに、そのアーカイブを選択して検索することができます。このよ

うにすることで、対象外のアーカイブの PV が検索されることがなくなり、Figure 3 の警告ダイ

アログもいちいち表示されなくなります。Figure 18は、BM/DCCTを選択してから検索すること

で、 他のアーカイブの検索結果が表示されなくなるという例を示しています。 

 

Figure 18 :  検索対象のアーカイブを指定して検索 

データソースは、プロット画面上に表示する際に重要なものになります。Figure 19 のように、

Properties ビューの上部にて項目を選択すると、下部にデータソースの一覧が表示されます。

Figure 19の例では、URLが kblog:///KEKBLog で、Keyが 12 で、Nameが BM/DCCT のア

ーカイブから BM_DCCT:HCUR の履歴データを取得していることを示しています。Archive 

Search ビューからプロット画面にドラッグをした場合には、このように 1 つのデータソースから

のみ履歴データを取得するようになっています。 
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Figure 19 : Propertiesビューに表示されるデータソース 

一方で、プロット画面上で右クリックして Add PV を選択して PVを追加するなどした場合には、

Figure 20のように複数のデータソースが Propertiesビューに表示されるはずです。ここに表示

されるデータソースは、Figure 17 にて設定したデフォルトのデータソースです。CSS はプロット

画面を描画しようとするときに、ここに表示されている全てのデータソースから履歴データを取

得しようとします。KBLogの場合、一つのデータソースごとに別々の kblogrdコマンドが実行さ

れます。つまり、Figure 20 の例では、BM_DCCT:HCUR の履歴データを取得するのに 40 回

ほど kblogrdコマンドが実行され、そのうち実際に履歴データを返すのは 1つまたは数個のプ

ロセスだけです。kblogrd コマンドを実行するのにはそれなりのオーバーヘッドがともなうため、

Figure 20 の例ではプロット画面を描画する際に CSS のレスポンスが少し悪くなります。このた

め、自分が閲覧しようとしている PVが属しているアーカイブが分かっている場合には、データ

ソースを指定して履歴データを取得させた方が良いでしょう。 

 

 

Figure 20 : デフォルトのデータソースから履歴データを取得しようとしている例 

Properties ビューにて、データソースを後から付け足したり、削除したりすることは可能です。

Properties ビューの下部のリストにて、右クリックをして Add Archive Data Source または

Remove Archive Data Sourceを選択してください。 
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2.9. KBLOGRDからのデータ転送量の節約 

デフォルトの設定では、Data Browser のプロット期間中の全データを間引きせずに kblogrd か

ら取得し、その上で時間区切りごとに平均値、最大値、最小値を計算してプロット画面にグラ

フを表示します。このため、長いタイムスパンで履歴データを見ようとすると、kblogrd の実行

自体に時間がかかってしまい、グラフが表示されるまでに長い時間待たされることがあります。

例えば、BM_DCCT:HCURについて、2010年 5月 14日から 2010年 6月 14日までの 1か月

分の間に約 268 万点の浮動小数点数が記録されていますが、これを Data Brwoser で表示さ

せようと思うと kblogrd からデータを取得するだけで 30 秒以上もかかってしまう場合がありま

す。 

そこで、kblogrd の”d”オプションを用いて、あらかじめ kblogrd 側でデータを間引くことである

程度この速度を速めることができます。この方法で kblogrd からデータを取得させるには、

「1.1.2 KBLog の設定」にて説明されているように、KBLog の設定ダイアログにて”Reduce the 

amount of data transferred from kblogrd”のオプションを有効にしてください。すると、上記の

BM_DCCT:HCUR の 1 か月分の例では 10 秒ほど表示されるまでにかかる時間が短縮され

ます。 

ただし、このオプションを有効にすると、各区間における平均値、最大値、最小値が表示され

なくなるので注意してください。 

2.10. KBLOGRDコマンドからのエラーメッセージ 

kblogrd コマンドの標準エラー出力は CSS のログ機構を通じてロギングすることができます。

kblogrdコマンドの標準エラー出力のログレベルは FINE に設定されており、デフォルトの設定

ではどこにもロギングされません。例えば、CSS の標準出力に表示させたい場合には、以下

の方法でロギングの設定を変更してください。 

まず、CSSのメインメニューから Edit → Preferencesを選択し、さらに Preferencesダイアログで

CSS Core → Logging を選択してください。Figure 21 のようなダイアログが開くので、ここで

Global Settings:の Log Levelを FINEに変更することで、kblogrdの標準エラー出力に吐かれる

メッセージが、Figure 22のように CSSの標準出力に出力されるようになります。Figure 22に太

字で示した部分が、kblogrd の標準エラー出力に吐かれたメッセージです（実際には端末上で

は太字では表示されません）。 
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Figure 21 : CSSのログの設定 

2011-12-22 17:50:05.079 FINE [Thread 57] 

org.csstudio.archive.reader.kblog.KBLogErrorHandleThread (run) - Error 

message from /usr/local/bin/kblogrd (132): BTHPMG:PULSEQ1:TOT_VMON not 

connected. 

2011-12-22 17:50:05.080 FINE [Thread 57] 

org.csstudio.archive.reader.kblog.KBLogErrorHandleThread (run) - Error 

message from /usr/local/bin/kblogrd (132): BTHPMG:PULSEQ1:IMON not 

connected. 

2011-12-22 17:50:05.080 FINE [Thread 57] 

org.csstudio.archive.reader.kblog.KBLogErrorHandleThread (run) - Error 

message from /usr/local/bin/kblogrd (132): BTHPMG:PULSEQ1:VSET_r not 

connected. 

2011-12-22 17:50:05.081 FINE [Thread 57] 

org.csstudio.archive.reader.kblog.KBLogErrorHandleThread (run) - Error 

message from /usr/local/bin/kblogrd (132): BTHPMG:PULSEQ1:SUBVSET_r not 

connected. 

Figure 22 : kblogrdからのエラーメッセージ 
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